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Hardware Requirements

ü 100 MHz or above Pentium processor.

ü 32 megs RAM.

üWindows 9x, ME, NT, 2000, XP on workstation running
Trans-Mit.

ü Faxing: One or more Class 1, 2, or 2.0 Fax modem(s)
connected to workstation COM ports.

ü E-mail: MAPI compliant E-mail program.
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About Trans-Mit

Trans-Mit enables Check Factoryâ users to E-mail or Fax
individual pages of a print job to separate locations based on
the E-mail address or fax phone number embedded in each
document page. Each page or group of pages for a particular
phone number will be sent together with a cover page to the
fax number provided. Each page or group of pages for a
particular E-mail address will be bundled in to a PDF file and
sent together with a cover message to the E-mail address
provided.

An example of a six page purchase order print job:

Page E-mail Address Fax Number Contact Name

1 555-555-5555 Jane Smith

2 555-555-5555 Jane Smith

3 555-555-5555 Jane Smith

4 George Wilson

5 mary@hope.com Mary Jones

6 mary@hope.com Mary Jones

Pages 1,2,3 will be faxed together to 555-555-5555 under one
cover page to Jane Smith

Page 4 will be sent to the printer because it has no E-mail
address or fax number.

Pages 5 and 6 will be e-mailed together in one PDF file to
Mary Jones. Mary can then view or print the form on her
printer.

ü Trans-Mit will E-mail using any MAPI compliant E-mail
program such as Microsoft Internet Explorer v5 or Netscape 
Navigator v 4.7 or above. The E-mail client must be
installed correctly on the workstation.

ü Each fax job can be scheduled to fax at a future time
and/or date in order to save telephone rates.
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ü Trans-Mit maintains three fax logs to trace the success or
failure of the individual fax jobs. The logs are: Sent Log, Out 
Box, Failed Log.

ü Individual faxes may be resent as many times as necessary
or deleted if the send was successful.

ü Trans-Mit is designed to be operated on a workstation(s)
connected to its own modem or modems. Trans-Mit can
handle faxing via multiple modems to increase throughput.
Trans-Mit does not operate with other fax server software.

ü Each workstation maintains its own fax log files. 

ü Trans-Mit does not receive faxes.

Where does Trans-Mit get the fax number 
and E-mail address?

The Contact Name, Fax Number, and E-mail Address are
passed to Check Factory as regular text inside the print job.

An example of what Check Factory would look for in a print
file:

||FAX1=555-456-9000||FAX2=555-566-8000||

||EMAIL=maryj@abcconst.com||

||FAXTONAME=Mary Jones||FAXTOCOMPANY=ABC
Construction||

We call the above code, “Trigger Codes”. They are created
using your accounting software’s report writer and distributed 
to you as modified reports. Check Factory and Trans-Mit do
not directly read your accounting software data files. They
receive all information via the print job.

Check Factory reads this information, creates a record in the
xxxx.FAX file for each page and then writes it to the Spool
Folder. Trans-Mit then generates TIF image files for each page 
of the print job and relates the pages to the phone and
address records of the xxxx.FAX file.

FAX1 is the primary Fax number and FAX2 is the secondary
number. If both numbers exist then FAX2 will be used for
faxing. If a valid E-mail address exists along with fax
numbers, the pages will be e-mailed unless overridden by the
operator.

Check Factory Trans-Mit 3



Installing Trans-Mit

Check Factory v 2.x must already be installed on your system
below your accounting software root directory. The serial
number of the Trans-Mit system must match the existing
Check Factory installation or Trans-Mit will install in demo
mode.

¨ Run the Trans-Mit SETUP.EXE on the installation CD
ROM. When prompted to select a directory to install to,
choose your accounting software root directory.

Example: F:\MYACCTG

¨ If you are installing a registered version of Trans-Mit you
will be prompted to insert your Trans-Mit registration
floppy disk at the end of the installation process..

Install a Trans-Mit Printer

A special printer must be installed for Trans-Mit even if you
already have a Check Factory printer installed. Trans-Mit
MUST use a HP Laserjet III printer driver.

¨ Click the Start button on your task bar.

¨ Select Settings, Printers.

¨ Double click on Add Printer.

¨ Click Next

¨ Click on Local Printer.

¨ Click Next.

¨ Select   HP   from the Manufacturers list.

¨ Select   HP Laserjet III   from the printers list.

¨ Click Next.

¨ If asked, Keep the existing driver.

¨ Click Next.

¨ From the Available Ports list select   C:\LFECF000
(Unknown Local Port)

¨ Click Next.

¨ Type in Trans-Mit for the printer name.

¨ You DO NOT want this printer to be the Default.

¨ Click Next.
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¨ You DO NOT want to print a test page.

¨ Click Finish
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Running Trans-Mit

ü In Check Factory the Trans-Mit program is accessed from
the Check Factory menu, Trans-Mit, Schedule / Send Faxes 
/ E-mail.

ü From the Windows Desktop, Start, Programs, Trans-Mit. 

Trans-Mit Main Window
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Edit Menu

Preferences, Workstation

User

Please enter your Name, Company Name, Voice Number and
Fax Number. This information will be used in your fax cover
pages and in the message body of your e-mail’s.

Spool Path

The “Spool Path” designates where the Check Factory will
generate the files necessary for the operation of Trans-Mit.
This folder should be on a LOCAL drive visible only to this
workstation. DO NOT attempt to place it on a network drive
where other Trans-Mit users could possibly access it. 
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Preferences, Fax

Dialing

1. Enter your local 3 digit local area code.

2. Enter the number of retries. We recommend at least 2.

3. Enter the retry interval. We recommend 5 minutes or 300
seconds.

4. Enter any numbers required to access an outside line for
Local calls.

5. Enter any numbers required to access an outside line for
Long Distance calls.

Note: Entering a comma (,) will cause a one half second pause 
that may be required after dialing the outside line access
code.
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Modems

If you are using the fax capabilities of Trans-Mit you must
have at least one fax modem listed on the Modems page. Press 
the Auto Configure button to search for and configure
modems on this station. Please wait for the operation to
complete before exiting the window.

Please perform the Fax Device “Auto Configure” anytime the
modem configuration of your workstation changes or if you
are experiencing difficulties in faxing.

If you will not be faxing from this station please check the
“Disable Fax” check box.

E-mail

Select Batch mode if you have large jobs containing many
e-mailed forms. Trans-Mit will generate all the e-mail’s before
releasing the job to your E-mail client. In this mode you may
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have to open your E-mail client and manually start the E-mail 
process.

If Batch mode is not selected Trans-Mit will create an E-mail
and you will have to wait for your E-mail client to send the
mail before it sends the next one. If you have a slow Internet
connection you may want to enable batch mode.

Maintain Messages

Fax Message

This is the message that will appear on the fax cover page.
You may create an unlimited number of messages. Prior to
sending your faxes you will be presented with the Job Control
window. Here you will be able to choose the message that will
be sent with the fax.

Use the File menu at the top of the Message Edit window to
Open, Save, or Save As or create New messages.

E-mail Message
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This is the message that will appear in the E-mail message.
You may create an unlimited number of messages. Prior to
sending your E-mail you will be presented with the Job
Control window. Here you will be able to choose the message
that will be sent with the E-mail.

Use the File menu at the top of the Message Edit window to
Open, Save, or Save As or create New messages.
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Test Menu

E-mail Test

Select the Fax Test option button to test the E-mail
capabilities of Trans-Mit. Enter a valid E-mail address.

Fax Test

Select the Fax Test option button to test the fax capabilities of 
Trans-Mit. Faxing must be enabled and at least on modem
must be configured in Preferences, Fax Preferences. Enter a
valid fax number that has a fax machine connected and
ready. 

Press the Perform Test button. The testing procedure closely
follows the actual procedure for sending faxes and e-mail’s via 
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Trans-Mit. You will be presented with the “Destination
Numbers and Address” window which will validate the fax
numbers and E-mail addresses. You will have the opportunity 
to make changes to the numbers and addresses. You may
also choose to only Print certain pages or not send them at all.

The Tools menu at the top of the window allows you to quickly 
change specific columns for all pages in the job.

Destination Numbers and Address

Once you have edited the numbers and addresses press OK to 
proceed to the Job Control  window.

Job Control
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Job Information

This tab tells you the name of the print job as it was defined
when printed from Check Factory.

E-mail Message

This tab allows you to change or edit the message body of the
e-mail’s that you are about to send.

Fax Message

This tab allows you to change or edit the message body of the
faxes that you are about to send.
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Schedule Fax

This tab allows you to schedule the send time of any faxes
that you are about to send. You may send them immediately
or any time in the future. The Faxman globe icon must be
visible on your work station for faxing to occur. Starting the
Trans-Mit program with faxing enabled will run the Faxman
fax server. Closing Trans-Mit will not shut down the Faxman
server and faxes will continue to be sent. Un-sent faxes
previously scheduled will be sent as soon as the Faxman
server starts.

User Information

This tab allows you to make last minute changes to the User
information prior to faxing or e-mailing.

Press the OK button to Trans-Mit your faxes and e-mail’s.
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Faxing a print job from your
accounting software

We assume that you are already familiar with printing forms
from your accounting software via Check Factory. If you are
not familiar with this procedure please consult the Check
Factory manuals before proceeding.

Important Printer Information!

Trans-Mit WILL NOT WORK with the Check Factory printer
that uses the HP Laserjet IV driver. Therefore YOU MUST add
a new printer called Trans-Mit that uses a HP Laserjet III
driver

You MUST print to the Trans-Mit printer NOT the Check
Factory printer when selecting a printer in your accounting
software.

Verify Fax Phone Numbers

Before proceeding you must first verify that you have the Fax
Number and Contact Name in each record of your vendor and
customer files. Trans-Mit needs this information to generate a 
fax job during printing. If Trans-Mit encounters forms that do
not have a fax number you will not be allowed to proceed until 
a number is entered. You may also choose to print it or to not
send it at all. This will greatly slow down the process and
some recipients may not receive faxes due to typing errors.
Print out a vendor and customer list and verify that each
record has a fax number.

Each fax number MUST include the three (3) digit Area Code
followed by seven (7) more numbers. Currently foreign phone
numbers not using the ten digit format are not supported.

Next print a batch of forms to the Trans-Mit printer. When
Check Factory intercepts the print job you will be prompted
with the following window:
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You have three choices at this time:

Print to Laser.

This will send the print job to the laser printer only. No fax job 
will be created.

Trans-Mit

This will generate a Trans-Mit job in the spool folder. Later
you will run Trans-Mit and actually send the job.

Trans-Mit and Print to Laser.

This will print the forms to the printer AND generate a
Trans-Mit job.

If you select number 2 or 3 you will be presented with this
window:
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All the fields in this window are editable. Generally you will
only enter a Job Description. This will help you remember this 
print job when you actually send it in Trans-Mit.

Check Factory will go through its printing operation. If you
selected Trans-Mit, it will have spooled the print job to the
\TMSPOOL folder on your local drive. The job is now ready to
be processed by Trans-Mit.
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Sending Trans-Mit Jobs

Select Trans-Mit, Schedule / Send Faxes from the Check
Factory menu. The Trans-Mit main window will appear.

Click on the ”Trans-Mit a Print Job” button. The Select
Trans-Mit Job window will appear. 

Choose the job to Trans-Mit from the list. You will now follow
the same steps as described in the testing section above.
Please refer to the testing section above.

FAXMAN fax server program.

If you have faxing enabled the FAXMAN globe icon will appear 
in the program bar at the bottom of your screen. FAXMAN is
the Trans-Mit fax server that actually does the faxing. The
FAXMAN icon will remain even if you exit the Trans-Mit
program. If you have scheduled faxes at a later time and or
date, the FAXMAN server program must be running when
those faxes are scheduled to fax.
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Fax Status Window

If the Trans-Mit program is running while Faxman is sending
faxes you will see the Fax Status window. 

20 Check Factory Trans-Mit



Trans-Mit Fax Logs

The Trans-Mit logs give you valuable information about the
status of all pending, completed, and failed fax jobs. From the 
main Trans-Mit window click on the View / Edit Fax Log
button. It will bring up the Fax Log window.

Clicking on the Out Box, Sent, and Failed buttons will display 
the respective logs.

Sent Log

The Sent Log displays all faxes that have completed
successfully. When you are satisfied with the contents of this
log please delete the entries.

Out Box Log

The Out Box log displays the all faxes that are currently
scheduled. You should not delete items from this log unless
you never want them faxed.

Failed Log

The Failed Log displays all faxes that failed the faxing process
for whatever reason. You may re-fax items in this log by
dragging and then dropping the item on the Send button.
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Once the item is dropped on the Send button the following
window will be displayed.

Displaying the Contents of a Fax

Double click on a line of any fax log will bring up the Faxman
Viewer. It will display the fax images.

Re-Sending A Fax

To re-send a failed fax simply drag the line from the log to the
Send button. You have the option to change or correct the fax
number prior to Re-Sending the fax.
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Job Maintenance

File Menu, Job Maintenance

Once you are certain that all faxes and e-mail’s have been
sent from a particular Trans-Mit job you should delete it from
the spool folder. Click on File, Job Maintenance. Choose the
job(s) to delete by checking the delete check box(s). Press OK
to delete the jobs.
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Appendix A

How does Trans-Mit work?

Your accounting application prints its print job to a HP
Laserjet III print driver connected to the file: C:\LFECF000.
Check Factory intercepts the print job by polling for the file
C:\LFECF000. Each page of the print job is inspected looking
for our “Trigger Codes”. The trigger codes are plain text
commands embedded in the print job by the accounting
software. The codes look something like:

|| FormID=INVOICE || DBLINK=Your Company Name ||
|| FNUM=555-234-5678 || FNAM= Joe Gomez || FCMP =
Gomez, Inc. ||
|| EMail = joe@gomezinc ||

You will notice that the code structure is delimiter (two
vertical bars), command, equal sign (=), argument, and finally
another delimiter or || Command = Argument ||

Check Factory locates the codes in each page of the print job
and performs the necessary action. The codes and delimiters
are stripped from the print job by check factory so that you
should never see them print on the page. 

FormID and DBLink select the form overlay to be applied to
the print data and DBLink selects the correct company from
the Check Factory database. FNUM, FNAM, and FCMP are the 
fax number, fax contact name and company to fax to. Email is 
of course, the email address of the recipient.

Check Factory spools the entire file to the TMSPOOL folder.
Each file is numbered with a description so that the Trans-Mit 
operator can later process the file in to faxes and emails.
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Appendix B

Where does Transmit get Fax numbers
and EMail addresses from?

Check Factory creates a parallel file to the print file that
contains all the fax numbers and email addresses for each
page of the print job. This file is processed when the operator
chooses to Trans-Mit the job.
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Appendix C

How can I interface Trans-Mit to my own
program?

The essential part of your interface is to pass the fax number
and email addresses within the print job so that Check
Factory and Trans-Mit can see them. We will do an example
using Crystal Reports.

Open a report in Crystal Reports (any version). Add a new
formula field to the report and place it somewhere on the
report where it will print on each page of the report. Call our
new field “TransMit”

Edit the formula field and create a concatenated string using
text and fields form your database. Database fields in the
example will have curly brackets around the field name and
text will be surrounded by quotes. Here goes…

“|| FormID = INVOICE ” +
“|| DBLINK = ” + {CompanyName} +
“|| FCMP = ” + {CustomerCompanyName} +
“|| FNAM = ” + {CustomerContactName} +
“|| FNUM = ” + {CustomerFaxNumber} +
“|| EMAIL = + {CustEmailAddr} +
“||”

Save the formula and on the report page make sure that the
field size is large enough to display the field. Even though you
will never see it printed it must actually print in its entirety on 
the page in cyber space! In fact do a test print directly to the
printer to make sure.

On the printed page your field would look something like this:

|| FormID = INVOICE || DBLINK = XYZ Company || FCMP = 
Gomez, Inc. ||
|| FNAM = Joe Gomez || FNUM = 555-555-3456 || EMAIL =
joe@gomezinc ||

One final thing must be done to our new formula field. THIS
IS VERY IMPORTANT! First make sure that the printer
displayed in the Crystal Reports File menu, Printer Setup is a
HP Laserjet III or HP Laserjet 4 printer. If you do not have this 
printer installed do it now. You will need it later anyway. See
“Install a Trans-Mit Printer” (above) Change the font on the
new field that we created to LINEPRINTER, 8 points. If you do
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not use a printer resident font Check Factory and Trans-Mit
will not be able to read the trigger codes.

Testing:

Print your report directly to the printer to verify that all of the
trigger codes are printing correctly and that they contain valid 
information and are surrounded by the || delimiter.

Next run the Check Factory program. Make sure you have at
leat one company installed. Minimize Check Factory. Print
your Crystal report that we just added the trigger codes to.
Print the report to the Trans-Mit HP Laserjet III printer on
C:\LFECF000. 

Check Factory will pop up and process the job. If necessary,
select your company and form (select Blank if you do not have 
an overlay ). When the Print to Laser window pops up, select
the Trans-Mit button. Enter a description for the job when
prompted. The job will now be spooled. Either now or
sometime later, bring up the Check Factory program, click
Trans-Mit on the menu and follow the prompts. Each page of
your print job will be faxed, emailed or printed, possibly to
hundreds of different locations with just a few keystrokes!
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